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Welcome! This is part 2 of the latest edition of my monthly Final Cut Studio newsletter for December, 2009

The goal of this newsletter is to provide information helpful to the interested user of Final Cut 
Pro. This newsletter publishes each month, past issues are available in my store. All 
software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find daily 
tips, the latest industry news, and over 450 articles and tutorials to help you get the most out 
of Final Cut!
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WRAP-UP

WELCOME

First, and most important -- a VERY Happy New Year - and new decade - to you!

This is my second newsletter for December. You can read the first December issue here. Since I was so 
late in getting the November issue out, I wanted to make up for it by providing two in December. Also, I 
have a ton of reader mail that I want to share with you.

I got a record number of comments on the first December newsletter - especially surrounding my 
commentary on a "Love Letter to LiveType." I'll be sending it, along with all your comments, to Apple after 
they return from their winter holiday in early January.

I am traveling to Dallas and Miami in January, presenting two new seminars. You can learn more and 
register here. I'll also be speaking at InFocus in Austin, TX, and AVP in Los Angeles. As well, I have a new 
series of video tutorials at MacProVideo. I'll talk more about that in a few pages.

2010 is dawning. May the new year - and new decade - bring your wishes to life. And enough work to keep 
us all busy.

Happy New Year to all of us! 

[ Go to Top. ] 

REVIEW: IMAGINEER SYSTEMS MOCHA FOR FINAL CUT PRO

A different approach to motion tracking.

IMPORTANT NOTE: As you'll discover, this review 
created a lot of comments, both positive and negative. 
Imagineer Systems asked me for my demo file so they 
could review it. In doing so, they discovered that I created 
a video that was difficult to track. Please be sure to read 
Ross Shain's comments on my demo file at the end of this 
review. I appreciate their interest and feedback.

When I first discovered the motion tracking in Motion 2, I was really excited. It was fairly easy to learn, easy 
to use, and delivered great results. While I don't do a lot of effects, it was nice to have this technique in my 
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tool kit.

Time passed. A few months ago, Ross Shain, from Imagineer Systems asked me if I wanted to review the 
newest version of Mocha. Mocha does motion tracking and the new version is specifically designed to work 
with Final Cut Pro. 

Imagineer Systems has been heavily promoting Mocha through user groups and email blasts, so I'd been 
hearing about it for a while. I told Ross that I was interested and he sent me a demo copy of the software.

I installed it about three months ago and it has been sitting on my system since then, troubling my 
conscience. So I set myself the goal of writing a review for this issue of my newsletter. However, that 
proved to be a bigger challenge than I expected. 

NOTE: I am not an effects wizard. If I were, I'd probably write an entirely different review. 
Instead, I approached this review from the point of view of someone who is knowledgeable 
about Final Cut Studio and is looking to add new effects software to their system. In other 
words, a new user of this software. 

TWO KINDS OF MOTION TRACKING

There are two ways of doing motion tracking. Some tracking software, such as Motion, uses points to track 
how an image moves over time. Others, such as Mocha, defines the shape as a plane; called a "planar" 
tracker. 

The benefit to tracking points is that they are easy to explain and to implement. This tracking works 
reasonably well for objects that move horizontally, vertically, rotate, or change in size. However, the 
limitations of this technique is that it does not do a good job on objects that change perspective.

The benefit to a planar tracker is that it handles perspective changes very well, at the expense of simplicity 
and fast learning curves.

Let me illustrate. 

http://www.imagineersystems.com/


Here's a test clip of me holding a white card and moving it from camera right to camera left. Notice that 
while the shape of the physical object (the card) remains the same, its shape on camera changes as I 
change the angle of the card to the camera. 

Here's the problem. The point-based motion tracker in Motion has no ability to change the perspective of 
the foreground sign. In other words, the motion track is "perfect," but the results are unacceptable. (Um, I 
borrowed the line for the sign from an REO Speedwagon album.)

NOTE #1 : This screen shot is mocked up to illustrate my point. The tracker software would 
change the size of the card as the card changes size, but not perspective; see Note #2 
(below).

NOTE #2 : While Motion does allow 4-point corner tracking using points, the tracker totally 
failed on my sample clip.

I used the top corners of the card for the location of my tracking dots. When the card gets in 
front of my gray T-shirt, the motion tracker can't distinguish between the top right corner of 
the card and my gray T-shirt. In the screen shot above, the red cross is locked on my T-shirt, 
not the card. So, it decides to follow the T-shirt and the track breaks. This could be solved by 
putting tracking dots (dark marks) on the card, but I didn't know this would be a problem until 
after I started working with the footage.

NOTE #3: The other problem with using the motion tracker in Motion to follow the four 



corners of an object is that the two bottom corners are obscured by my hands which also 
causes the tracking to break.

These three important notes illustrate a key point: It is critical to test your ideas before getting into the heat 
of production to make sure you can actually do what you are hoping to do.

In this case, Motion can't track this card.

TRACKING USING PLANES 

As you may remember from high school geometry, a plane describes a flat surface extending out infinitely 
in two dimensions. As that plane moves around, any objects attached to that plane will change their 
perspective.

In other words, Mocha has the ability to solve the problem of perspective changes created by the changing 
shape of an object as it moves thru space by tracking it as a plane, instead of a couple of dots.

And, Mocha now integrates with Final Cut Pro. So, let's see if we can use Mocha to solve this tracking 
problem.

What Mocha does is that it turns the object you want to track into a plane, then generates tracking data to 
be applied to the foreground clip in Final Cut. You could do the same thing manually using the Distort 
settings in the Motion tab, only Mocha is much faster and MUCH smoother.

GETTING STARTED WITH MOCHA

I found getting started with Mocha a very frustrating experience. This is because I decided to read the 
manual and watch one of their generic tutorials Imagineer had posted to the website.

After watching, I was far more confused than when I started.

Then, I discovered Ross Shain's Mocha demo for Final Cut - also posted to the Imagineer website - which 
was far superior to anything else they had. (For more thoughts on the power of bad training to scare 
customers, refer to my editorial later in this issue.)

However, Mocha is not like most other Mac applications. It doesn't look like any application in Final Cut 
Studio and it doesn't act like it. It took me hours to finally figure this out. So, to save you time, let me walk 
you thru the steps.

Here's the basic workflow:

1.  Open the clip in Mocha that you want to generate the tracking data FROM. 
2.  Define the area you want to motion track.
3.  Generate the tracking data.
4.  Export the tracking data in a form that Final Cut Pro can read.
5.  Copy and paste that tracking data in Final Cut to the clip to which you want to apply the tracking 

data.
6.  Render your clip.

OPENING MOCHA AND IMPORTING YOUR CLIP

Mocha only allows one clip to be open at a time in a project. This means that you only need to import the 
background clip, the one that has the object you want to track -- in my case, the clip of me holding the white 
card.



When you first start Mocha you see the opening screen. This screen looks really impressive, but does 
absolutely nothing. When you actually try to do something, as I did, you'll get really frustrated.

This is because this opening screen is not a new project. its just a screen.

To create a new project so you can import a clip, you need to do one of two things:

1. Choose File > New Project (or press Command+N) -- or --  
2. Open Mocha so you see the opening screen, then drag your clip from the Finder on top of 
the Mocha icon in the Dock. (Don't drag the clip directly into Mocha, it won't work. Nor will 
dragging a clip out of Final Cut onto the Mocha icon.)



Either way, Mocha displays the New Project Wizard. If you dragged a clip onto the Mocha icon, you'll see 
your clip name displayed at the top of the window. This is the first of three setup screens you need to 
complete. 

If you simply created a New Project, click the small orange folder in the top right corner to display a file 
picker dialog to select the file you want to import.



By default, Mocha stores your project data in the same folder as your source clip. I prefer creating a 
separate folder for my Mocha data, so I created a folder on my second drive titled: Mocha data. Then, 
clicked the Absolute Path button to point to that new folder. 

To point to this drive, change the Project Output Directory to Absolute, and click the lower orange folder 
button on the right side, to display a file picker window and select the folder you want project data stored in.

Click the Next button in the lower right to move to the second setup screen.



By default, Mocha uses the entire duration of your clip. In this second screen, you can set the playback 
range so you are just tracking a portion of the clip. 

To adjust this, change the frame settings in the First Frame and Last Frame text boxes.

If your clip is stored locally on a hard disk, uncheck Cache Clip. If your clip is stored on a slow device, like 



a server, checking Cache Clip will speed performance.

In this case, my clip is on a fast second drive, so I'll leave Cache Clip unchecked.

This is the third set-up screen. 

The only KEY thing to verify is to be sure that the FPS (Frames per Second) frame rate exactly matches 
your clip. Otherwise, bad things happen.

In my case, all these settings are correct, so I click Finish in the lower right corner.

And you are now ready to start. Whew. 

SIDEBAR: CLOSING A FILE AND NOT SAVING CHANGES



Let's say you imported the wrong file, but didn't realize it immediately. To close a file and not save changes 
is particularly obtuse in Mocha. Let me illustrate. 

Select File > Close Project. This opens the Save Project window. If you click OK, the file is saved in the 
project location you specified when you first created the project. 

However, if you UNcheck the Save project checkbox in the lower left corner, your project is NOT saved. By 
default, Mocha always saves your project. Which means you need to pay really close attention if you want 
to reset your project without saving changes.

In other words, OK either saves or doesn't save your project. This is the only Mac application I know of with 
this non-standard way of saving or exiting a file.

Also, as another non-standard behavior, closing a project also quits Mocha.

MOTION TRACKING A CLIP

Now its time to track the clip. Mocha defines areas using either splines or Beziér curves. Mocha 
recommends using splines, so that's what we'll use.

Go to the tool bar at the top and select the Spline tool. Splines are saved to layers in Mocha. 



Starting outside the area to be tracked, click once to set a starting point. Then, click to draw a rectangle 
around the object to be tracked. Be sure to include the entire object. 

IMPORTANT: Control-click or right-click AFTER setting the last point to close the shape.

Grab the dot at the end of a control point and drag it to determine the sharpness of the corner.

NOTE: Once you have set a shape, there is no way to delete it. The only way to delete a 
spline is to select each point and delete it by pressing the Delete key. One at a time. Nor is 
there a way to delete tracking data once it has been created. The only way to reset a project 
to is close the existing project without saving changes. This inability to remove splines and 
reset data is a major frustration. You can remove layers, but not the objects on a layer. 

In the lower portion of the screen are three tabs: Clip, Track, and Adjust Track.



According to Mocha, tracks will be better if you reduce the Min % of pixels used to less than 50%. So, I set 
mine to 40%.

Also, because we want to track changes in Perspective, be sure the Perspective checkbox is checked in 
the Motion section. It is off by default. 

The symbol for the playhead is a small vertical black bar, which is almost impossible to see when it is at the 
beginning or the end of a sequence. Tasteful is nice, but seeing an essential part of the interface is far 
nicer. 

Reset the playhead to the start of the clip by pressing the far right Go to In button. While this step isn't 
really necessary, as Mocha can track in reverse from the end of the clip, it helps me to see things 
progressing normally.

Once you have defined the area to be tracked, and assuming your playhead is at the head of the clip, press 
the Track Forward button.

Tracking speed depends upon the speed of your computer and the length and complexity of your clip. 
However, this would be a perfect time to go get a cup of coffee and visit with your family.

Once the track is complete, you need to fine-tune what the data is that will be exported. This is a process 
Mocha calls: Adjusting the Track. 

ADJUSTING THE TRACK

On simple shapes, Mocha may not need any adjustment. However, on this move, from one side of the 
screen to the other and back again, watching the position of the surface showed problems with the track.



To see the precise effect of your track on this object, click the Surface button on the right side of the 
window. This displays a small blue rectangle superimposed near your tracked object. Grab each corner of 
the rectangle and drag it so that it matches the shape of the surface. 

This is an essential step, as this determines the precise data that Final Cut will use to create the finished 
track. 

NOTE: According to Mocha, the surface rectangle can not be keyframed. This means that if 
there is a problem, you can't fix it by adjusting the shape of the surface rectangle. You need 
to add tracking keyframes; which I'll talk about in a minute.



You can also get a sense of the perspective of the track by clicking the Grid button, just below the Surface 
button. This shows a planar grid that tracks with your object. 

Notice that by the time I moved the card to in front of me, the blue surface rectangle was off on three of four 
corners. This means that my track has already started to develop errors.

Position the playhead on the frame you want to adjust and click the Adjust Track tab in the lower left 
corner. This sets a tracking keyframe to allow you to adjust each of the four corners of your surface.

NOTE: Mocha recommends creating as few keyframes as possible, to keep your tracking as 



smooth as possible.

To make this adjustment process easier, Mocha provides closeup images showing the selected reference 
point so you can compare the original position of the tracking point with the current setting of the reference 
point.

After you make all necessary adjustments, so that the surface rectangle tracks properly with the movement 
of the object, you are ready to export your data. In this example, I spent about 45 minutes creating 
keyframes and adjusting the track. 

In creating my track, I was surprised at how many adjustments I needed to make. The corners kept drifting. 
In this nine second video, I needed to add six keyframe adjustments to the track.

NOTE: In doing this track, I realized I made a big mistake in production. Notice in the video 
tutorial Imagineer created, the four corners of the object are clearly visible at all times. In my 
video, my hands covered the two lower corners, which made finding consistent reference 
points impossible. 

This meant that two of the key references Mocha needed to create a track were obscured by 
my fingers. I clearly did not think about this when I shot the video. But it made my motion 
tracking far harder, and less accurate. For this reason, it is essential that you think through 
any special effects you plan to use before you shoot your video. 

EXPORTING TRACKING DATA

All Mocha does is create tracking data. All compositing and finishing are done in Final Cut Pro. Which 
means that we need to get the data out of Mocha and into Final Cut.



Click the Track tab at the bottom of the main window. If Export Tracking Data is grayed out, 

... click the magenta bounding box surrounding your object in the Canvas window to select it.

By default, Mocha labels layers as Layer 1, Layer 2, and so on. You can rename a layer by clicking it in the 
top left corner, under Layer Controls. In this case, I gave it a more helpful name.

Click Export Tracking Data to export your data. Getting data back into FCP requires creating an XML file. 

There are two types of files that can be created: Motion and Distort. If your object is changing position, 
using Motion. If your object is changing perspective, use Distort.



In this case, I selected Final Cut Distort.

Click the Save button, give your soon-to-be-created file and name and location and click Save.

At this point, you are done with Mocha. Save your project if you want to refer back to this later: File > Save 
Project. You can now safely quit Mocha. 

FINISHING THE PROJECT

I created a Final Cut Pro project containing the background clip and a sign to insert into the background 
based on the motion track data we just created.

To import the motion track data, select File > Import > XML and navigate to the motion data file.

In the Import XML dialog, be sure to select the project file you want the clip to import into. Keep all three 
options checked, and click OK.



A new clip appears in the Browser -- the motion tracked clip you just created in Mocha. It is highlighed in 
this screen shot. 

To copy the tracking data for pasting onto a new clip, Control-click the XML clip and select Copy.

Select the new foreground clip in the Timeline and choose Edit > Paste Attributes.



In the Paste Attributes dialog, turn OFF Scale Attribute times and turn ON Distort. Click OK. 

NOTE: If you exported using Motion data, you would uncheck Distort and check Basic 
Motion.)



Play your clip and see how the new sign is tracked onto the background.

NOTE: For better results, try using Modify > Composite Mode (in this example, I'm using 
Multiply).

FINAL THOUGHTS

After watching the demos and reading the manual, I'm convinced that Mocha creates motion tracks that 
can't be created any other way. And, if you have a background in effects software, you will probably find 
Mocha easy to use.

However, I was extremely disappointed in the quality of Imagineer System's on-line tutorials - they showed 
without teaching. (Ross Shain's tutorial was the notable exception.) The tutorials were geared to people 
who already knew what they were doing, not to people who were trying to learn. I found them very 
frustrating.

The Mocha manual did not provide answers to common problems experienced by new users, not did it 
provide tips on how to shoot materials that need to be motion tracked. The inability to delete splines or 
reset clips, non-standard file saves, and adjusting mis-behaving tracking points I found disconcerting.

I was also surprised by the number of errors that appeared during the creation of the track.

Integration with Final Cut is about as good as Final Cut will allow, so, while cumbersome, that isn't 
Imagineer's fault.

If a significant amount of motion tracking is in your future, Mocha should be considered. However, if you 
are new to the field, allow plenty of extra time for learning and experimentation. Also, expect to be really, 
really confused for a period of time as you are learning the software.



Finally, remember that the key to creating great looking effects is spending time thinking about how to 
shoot them in production, not trying to figure out how to fix it in post.

UPDATE - Jan. 2, 2010

Nicolas Nilsen writes:

I agree totally. Each tutorial should have - at the end - not only a chapter dedicated to 
troubleshooting but also, in some chapters - some sort of warning going like this : “here you 
might be tempted to proceed like this, because it seems obvious - well don’t, because 
(showing the mistake) this is what you would get…”. I mean that sometimes, showing the 
mistakes is as useful as showing the right way. Anyway, you’re right Larry : the idea of a 
good tutorial is for us to be able to cook and eat the damn rabbit ; not just see how easy it is 
for you to kill it ! With all my best wishes for 2010.

Norman Hollyn sent this in:

Great points in regards to tutorials. Marketing departments at the major software 
manufacturers should get their hands off of tutorials. There’s a place for what they do — on 
the sales pages. But, too often (in their urge to “brand” themselves and their products) the 
marketing departments are given license to create or, at least, vet the tutorials. This is a 
recipe for disaster.

In regards to the form for a tutorial, a pretty good rule for any sort of teaching is to do the 
following three things:

1 - tell people what they are going to learn, 
2- teach people, 
3 - tell them what they’ve just learned.

This helps the “student” to situate themselves within the teaching. And most people, 
especially the creative types who you are working with, work better when they can see the 
overall picture of their learning.

Mark Spencer adds:

Great article. I've been working with Mocha for FCP as well and have to agree with many of 
your comments. There's an interesting workflow that extends on what you did by then 
sending a clip from FCP to Motion with the tracking data for further refinement which I'm 
planning to explore in a future tutorial.

Anyway, I think Mocha is a very good product with an obtuse UI and poor documentation but 
a lot of promise, and they are lucky to have Ross to help make it easier to understand. 

Great points also about the distinction between a demo and a tutorial.

Kit Laughlin, from Kambah, Australia, adds:

Lastly, as a workshop presenter myself, I loved your analysis of Motion. This is THE problem 
in learning new software: the tutorial authors assume that the newbie understands the 
context in which the new software is situated, or that the newbie understands how the 
software thinks. Explaining how a function in some Tab works is not a substitute for this 
scene-setting. A huge two thumbs up to you for pointing this out.

UPDATE - Jan. 4, 2009

Ross Shain, from Imagineer Systems, writes:

Hi, Larry. Thanks for your honest critique. I really appreciate your time and willingness to put 



mocha for Final Cut and the materials through the paces. It is clear to us that the FCP 
market requires a different type of training and docs than we currently provide. Imagineer's 
history and experience has been in high end visual effects and some of our challenges to 
reach a wider market (especially in editorial) are illustrated in your blog post. 

I would like share that we do get emails every day from users who rave about mocha, its 
ease of use and how it has changed people's workdays. The fact that Adobe bundles our 
products and recent customer survey results show me that we are doing something right for 
many users and markets. 

But believe me, in no way does this invalidate your opinion and I completely agree with many 
of your points. I will do my best to have some of these training and documentation issues 
addressed. We know that Mocha is a very valuable tool.

Larry replies: Thanks, Ross, for sending this. I am always very reluctant to say bad things about any 
product, because I know how much work is involved in creating anything. I think that Mocha has a great 
deal of potential, once some clearly fixable things get fixed. 

Stace Carter, adds:

Larry, I'd agree with you that Mocha isn't incredibly intuitive - I also found that as a new 
Mocha for FCP user I realized early on that without a fairly comprehensive understanding of 
FCP many users would be completely lost. That being said, what this app helps you 
accomplish is not simple stuff - generally relegated to the higher-end of effects and finishing. 
Planar tracking, for those who've had to roto frame by frame, is just like magic ;-) The fact 
that I can track HD footage on my laptop and finish the comp in FCP, in just a few steps, is 
even more magical. 

SO... while I can't completely disagree with you about the out-of-the-box simplicity of the 
instructions, I feel you're overlooking the amazing support that's available from this great 
company. I posted a few early questions to the Imagineer support forum and received quick, 
thoughtful and helpful replies from Martin Brennand - the kind of assistance one would never 
expect from a software company these days. 

Like yourself, I also work as a trainer and understand that teaching (or more importantly, 
helping folks learn) involves a unique approach and skill set, not just knowledge of the topic. 
With that in mind, I can't justify holding the Imagineers feet to the fire for not having better 
tutorials - they are obviously a small, nimble and talented company and focus on what they 
do best. At worst, I think their emphasis on product design – and customer service - simply 
leaves an opportunity for folks like you and me to teach more seminars and classes.

PS – In re-reading this post I sound like I work for these guys – I have no dog in this fight, I 
was just really impressed with the level of service I received from Martin and feel you’ve 
overlooked an important aspect of the company and product, the great customer service.

Larry replies: Thanks, everyone, for your thoughts!

UPDATE: Jan. 5, 2010

Ross Shain, of Imagineer Systems, writes:

Larry, thank you for posting your demo file for me. Here are a few things to note.

I watched the file and could immediately see some of the issues that you had with your track. 
There is no detail in the white paper that you are holding, the bottom 2 corners are obscurred 
by fingers and there is a shadow that comes and goes. In a situation like this, often the DP or 
effects supervisor would add small track marks on the object the actor is holding to aid the 
tracker and save time in post. 



  
  
  
  
  
  
  
  
  
  

The good news is even while most experienced compositors would agree with me that your 
shot is not a simple track, with mocha I was able to get a very good result within 15 minutes 
including the time it took to add some adjust track keyframes. 

1. The shape that you created is too large - without any detail on the paper and with the 
shadow, it is important to create a "pattern" in mocha that is trackable. All the pixels in a 
defined shape represent a pixel pattern that mocha uses to find on the next frame. See the 
attached screen shot to see the shape I used as a search area. It ends up being very similar 
to the shape I created and demonstrate in the mocha for Final Cut QuickStart tutorial.

2. I left the "minimum % of pixels to use" in tracking tab at 90%. This parameter can aid a 
track's accuracy depending on how much detail is in the actual shot. I left it at the default for 
this shot. 

3. While tracking as the hands move a little, I stopped the tracker and adjusted the actual 
shape a few times, and kept tracking. 

4. Lastly, I did need to add some adjust keyframes...about 15 which is really not bad for this 
duration clip with the problems described. 

I will see if there is time this week to do a tutorial on this shot. Because of the issues 
described, it doesn't make for the most glamlourous tutorial and in general while I agree with 
many of the user comments a tutorial is not a demo, there is an element of interest or 
excitement to consider when choosing the right footage to focus on. Either way, I do hope 
that this is useful for you....

Again, I am sorry that you got so frustrated in your training process and do wish you had 
contacted me during this time. I think that most of our customers, even those that start off 
frustrated, end up being huge fans once they get over the learning curve. 

Lastly, one of the largest features in mocha for Final Cut and mocha shape FxPlug is the 
ability to track and cut mattes for color correction, blurs, etc. I am confident that this is a very 
useful feature as FCP is so limited in roto and matte creation. If you can overlook all the 
issues you have had so far, I am sure that you and your readers would find this very useful. 



Mocha Shape is detailed here:  
http://www.imagineersystems.com/products/mocha_shape_for_Final_Cut/

Larry replies: Ross, thanks for showing ways to improve the tracking results with Mocha.

What might be more useful than simply creating a tutorial is to explain what makes good video for tracking. 
Feel free to use my video as an example of what not to do and illustrate what should have been done 
instead. This kind of comparison would be MUCH more useful than just another tutorial. 

As I mentioned in my review, proper planning before shooting effects is critical. However, if you don't know 
what to plan for, you end up with very difficult material to work with.

[ Go to Top. ] 

LARRY IS ON THE ROAD IN JANUARY 

I am training and speaking all over the country in January. Come visit one of my seminars near you:

Jan. 11 - Miami, FL. Seminar: PowerUP Tools for a Down Economy. Learn how to get more 
done with less effort, and save money -- this seminar emphasizes visual effects and audio. 

Jan. 16 - Dallas, TX. Seminar: PowerUP Tools for a Down Economy. Learn how to get more 
done with less effort, and save money -- this seminar emphasizes visual effects and audio.

Jan. 17 - Austin, TX. InFocus Video Event. Larry is doing a special four-hour presentation at 
this event geared toward wedding videographers. Trouble-shooting, working with stills, new 
FCP 7 and lots of Q & A. All at a GREAT price! 

Jan. 29-30 - Los Angeles, CA. Assn. of Video Professionals. Save 10% use promo code: 
FCPGURU. Larry is doing two in-depth presentations on Final Cut Studio covering color 
correction, working with stills, new FCP 7 features, and picking the right HD video format. 

[ Go to Top. ] 

EDITORIAL: TRAINING THAT DOESN'T TEACH

These thoughts have been bubbling around my head for the last few months, but developed into an article 
as I was trying to learn Mocha from Imagineer Systems. They also provided the philosophy behind my 
recent book for Focal Press: Adobe CS Production Premium for Final Cut Studio Editors.

As always, let me know what you think.

The folks at Imagineer Systems sent me a demo copy of Mocha, which is used for motion tracking. After 
installing the software, which proved very easy, I launched it only to discover an opening screen 
intimidating enough to scare most adults.

Hmm... time for some training myself.

It just so happened that Imagineer was holding a training workshop locally in LA, so I signed up. I spent a 

http://www.imagineersystems.com/products/mocha_shape_for_Final_Cut/
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.infocusvideoevent.com/blog/2009/09/larry-jordan-fcp-workshop-50-for-infocus-attendees-75-for-everyone-else-topics-and-registration-info-bottom-of-post.html
http://www.aovpros.com/conference
http://www.imagineersystems.com/
http://www.amazon.com/Adobe-Production-Premium-Studio-Editors/dp/0240812239/ref=pd_sim_b_3


couple of hours at the session, did my tracking and thought: "Wow! Piece of cake."

Then, I came home. Work intervened. Time passed. I didn't open it again for a couple of months. But I was 
feeling guilty and realized I needed to write my review. So, during a recent video shoot I recorded a short 
clip of me moving a white card around. I decided to create a motion track of this in Mocha as a way to learn 
the software.

My experiences in trying to get that card tracked was the inspiration for this editorial -- because Imagineer 
has made it really difficult for new users to figure out how to use their software.

I am not a motion graphics designer. I am in awe of the talents of folks like Mark Spencer, Damian Allen, 
Tom Meegan, and many other wizards who make magic happen with a couple of quirky shapes, a dark 
background, and two or three blend modes.

Suddenly... poof, Poof, POOF! They have the opening to Monday Night Football.

All I want to do is replace the graphic on a card my talent is holding because he grabbed the wrong prop 
and no one noticed it during production. Or the logo on the stupid cap worn by the stupid talent has the 
wrong stupid logo on it. 

You know, the stuff that drives you nuts.

So, I open the Imagineer manual and start reading. I get about six pages in and I'm feeling lost. So, I go to 
Imagineer's website and watch their intro tutorial. Not only do I get lost, I start getting angry.

After reading the first chapter in the manual, and watching the entire "Learning to Use Mocha" tutorial it 
was impossible for me to figure out how to use the software. The narrator of the tutorial kept describing 
Mocha as "intuitive." If you already understand motion tracking and have used a variety of other high-end 
tools, he may be correct.

But it isn't intuitive to a new user.

NOTE: After some searching, I found a demo on Imagineer's website of Mocha for Final Cut 
Pro by Ross Shain which is very good. As a suggestion, if Ross isn't doing the tutorial, don't 
bother wasting your time watching it. 

After years of doing training myself, I know that the hardest person to teach is the new user. It is so easy 
for them to get lost and so hard to get back on track.

That's what makes video training on the web so great. You can watch the same video over and over until 
you understand. Provided the person doing the training realizes the difference between a demo and 
training. And that is where Imagineer got lost.

A demo is what you do to show how spiffy your new product is. Demos are all speed, polish, fancy tricks 
and glitter. You hide the hard stuff with fancy footwork and glib patter. Demos get people excited. Apple 
has turned the demo into an art form. A demo is created to impress.

Training is what you do when you want people to learn a product. It explains where to click and why. It 
creates a solid foundation then builds from there. It takes longer and moves slower. Training creates 
understanding.

Imagineer's tutorials and manuals lost sight of that.

Because my reactions were so strongly negative to what I was reading and watching I came up with some 
simple rules that folks that do training need to follow, most of which Imagineer forgot.

1.  Give us an overview of the steps before plunging into the process.
2.  Always explain exactly how to create a new project. 
3.  Always show exactly where to click - show, not describe.
4.  Show something simple before showing something complex.



5.  Always show exactly how to save and export project data, and whether what you choose makes a 
difference.

6.  Always show exactly how to get your information back into the application that needs it.
7.  If the default settings don't yield the best results be VERY clear what needs to be changed. 

Here are some specifics: 

�●     Most Macintosh applications create a new project when they are first opened. But not Mocha. It 
displays a work screen, which isn't the same as a project. You need to select File > New Project 
before you can do anything. 
 

�●     The Learning Mocha tutorial runs about 12 minutes. Never ONCE did the narrator say "Click here" 
and show us where to click. Instead his mouse would fly so quickly across the screen the 
compression software would lose sight of it. He referred to the location of where to click in the 
jargon of the application; for example, "Click in the View tab." However, the only thing displayed on 
the screen was the View menu - which is not the same thing. 
 

�●     Yes, Mocha is a sophisticated program. Yes, it does a lot. But we need to be successful doing 
something simple before we can move on to the complex. If I can't successfully do the easy stuff, 
there's no incentive for me to waste my time figuring out the hard stuff. 
 

�●     In training you are not trying to convince me how wonderful the software is. You need to convince 
me that I'm smart enough to be able to use it. Start simply. Build slowly. Lead me by the hand to the 
complex stuff. If at the end I lean back and say, "Wow, that trainer is smart," you've failed. If, on the 
other hand, I lean back and say, "Wow! I never knew I could do that!", you've succeeded. 
 

�●     Like Soundtrack Pro or Final Cut Pro, saving a Mocha project saves the instructions on how to 
motion track, it doesn't actually save the track data in a form that Final Cut can use. Exporting does. 
Exporting is essential as it is the only way you can get motion data into Final Cut. However, there 
are two types of exports Mocha provides for Final Cut - the default setting, which doesn't handle 
perspective changes (which is why you bought Mocha in the first place), and a second export option 
which should be the default, but isn't. It would be nice if they made that clear. 
 

�●     If the default settings don't yield the best results, and there are two instances where the default 
settings lead you severely astray, take extra time to show what needs to be changed and why. 
 

�●     Once you learn a piece of software, creating new files, importing media, exporting data and saving 
your work is easy. UNTIL you learn that software, not knowing one of those four steps makes it 
completely impossible to use. The on-line tutorial forgot this point. 
 

�●     Getting motion tracking data back into Final Cut Pro is not simple. It takes a minimum of four steps, 
two of which are not obvious. The manual discussed this, the on-line tutorial did not. (This was 
remedied in the Ross Shain tutorial, but that is not the featured tutorial on their website.)

Training is not easy. Yet without it, a company loses the ability to gain new users, improve its market share, 
or continue to grow the skills of their existing users. Inadequate training frustrates new users and creates 
the impression that products from that company are not worth the money they cost, as they are too hard to 
use.

None of us benefit from training that doesn't teach.

I posted these thoughts to my blog (click here to read) over the weekend and Nicolas Nilsen sent me one 
of the best descriptions of this that I've read in a long time. He wrote:

The idea of a good tutorial is for us to be able to cook and eat the damn rabbit; not just see 
how easy it is for you to kill it! 

UPDATE - Jan. 2, 2010

David Fisher writes:

http://www.larryjordan.biz/blog


Your editorial excoriating badly conceived software tutorials resounded with those of us who 
have endured the inadequacies of software training, documentation, and tutorials. Thing is, 
what attention will the offenders themselves pay to this critique?

My own experience may contribute to answering that. A few years ago, despairing of having 
spent thousands of dollars on technical texts over the years and found very few which 
actually worked reliably, I suggested to Wiley and Microsoft Press that they hire me as an 
editor, charged with the job of subjecting their new works to the kind of scrutiny that would 
potentially save readers from experiencing the frustration of following directions that could 
not safely be relied upon. Both companies listened, considered my proposal, and then 
elected to continue doing business as usual.

Larry replies: Yup. We can point out the problems, but we can't fix them. 
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LARRY RELEASES NEW VIDEO TUTORIALS ON MACPROVIDEO.COM

One of the requests I get a lot is for a 
series of introductory videos for people 
that are new to the industry.

So, over the last several months, I've 
been working on a series of short video tutorials that answer basic video questions, without getting bogged 
down in specific technology. These are designed for interested beginners, rather than experienced 
professionals.

Currently, I have eleven episodes created with two more to arrive before the end of this year. Each tutorial 
runs 6-10 minutes and topics include:

* Improve your Shooting in HD 
* Tips to Improve Audio 
* Tips to Improve Lighting 
* Getting Organized for Editing 
* Picking the Right Microphone 
* Lighting with Soft-lights

Thanks to a new partnership with MacProVideo, all these tutorials can be downloaded, or viewed in their 
on-line library. If this first set of tutorials proves popular, I'll be off to the studio to shoot some more. 

MacProVideo started a whole new section for us -- called Audio/Video Fundamentals. My tutorials are in 
the Digital Production BuZZ section. 

If you are just starting out, or have a friend that is pestering you for guidance, take a look at these tutorials. 
These aren't available anywhere else and are designed to help new users avoid unnecessary mistakes. Let 
me know what you think.

Find out more here: http://www.macprovideo.com/tutorials/avfundamentals

Also, I've also released one of my most popular tutorials through MacProVideo as well:  
Picking the Right HD Video Format. You can find it on this page, as well. 
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WHEN SHOULD I UPDATE TO SNOW LEOPARD?

Steve MacDonald (and many others) sent me the following question:

Concerning Snow Leopard, I was hoping you could shed some light on all the issues it has 
with Final Cut 7. The reason I ask is because it is getting next to impossible to buy a new 
Mac that doesn't have this. I look forward to your reply, thanks Larry!

Larry replies: Steve, there are four answers to this question. Pick the one that best fits your situation.

1. You need new gear and you want to run Final Cut Studio 
2. You want to take advantage of new Snow Leopard features within FCP 
3. You need to run 3rd party hardware or software with FCP 
4. You want to upgrade your existing system to Snow Leopard

BUY NEW GEAR

If you buy a new computer, today, it will have Snow Leopard installed on it. If you then install Final Cut 
Studio (3) on that computer, Apple tells us that it will run fine.

So, if all you need is a new computer to run Final Cut on, you can purchase the gear now and get to work. 
My wife recently bought a new MacBook laptop with Snow Leopard and she's completely happy. On the 
other hand, she's not using it to edit video.

USE NEW SNOW LEOPARD FEATURES

Keep in mind that the current version of FCP does not support 64-bit memory addressing, which means it is 
limited to 4 GB of RAM. It does not support Grand Central Dispatch, which means that it does not take 
advantage of all the processors in your system. In fact, there are no new features that become available to 
you in Final Cut when you upgrade to Snow Leopard.

So, if you want Final Cut to do something more than it can do in OS X 10.5, there's no reason to upgrade, 
because the operation of FCP remains the same in both 10.5 and 10.6.

While Apple does not comment on unannounced products, I don't expect FCP to support the new features 
in Snow Leopard until the next major release of Final Cut Studio. And I'm not expecting that for many, 
many months.

RUN 3RD-PARTY HARDWARE OR SOFTWARE

The answer to this question is trickier. Most plug-ins are now Snow Leopard compatible... but not all of 
them.

Until recently there have been issues with Panasonic P2 cards, DSLR compatibility, and Sony SxS cards 
used by EX3 cameras. (I'm currently in the middle of a shoot using Sony EX3 gear. For this reason, I've 
held off upgrading because I can not afford the risk that my EX3 cards won't mount and capture.)

If you have an existing OS X 10.5 system, carefully check to be sure all your plug-ins either support, or 
have upgrades to support Snow Leopard. If they all work, go ahead and upgrade.

UPGRADING AN EXISTING SYSTEM

There's no doubt upgrading an existing operating system is exciting. All kinds of new toys to explore.

At this point, Snow Leopard is stable and most plug-ins support it.

For me, it comes down to the issue of what do I get for the time I spend upgrading? For me, at the moment, 
I don't get enough.



It takes time to upgrade my existing gear, which is currently working fine. It will take more time to be sure 
all my plug-ins, hardware, and other software tools are working or download and install all necessary 
updates.

All to get no new features in FCP.

To me, this doesn't make sense. 2010 will be year we see LOTS of new software that takes advantage of 
Snow Leopard. One of these days I'll see an application I just can't live without that will justify the time 
necessary for an upgrade.

But, for me, that tipping point has not yet appeared.
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THOUGHTS ON APPLE'S IFRAME VIDEO FORMAT

A couple of issues ago, I wrote that Apple had released a new video format called "iFrame."

A blogger ostensibly covering the video industry took Apple to task for this format with a diatribe that was 
both ill-informed and unnecessarily harsh. If you don't know what you are talking about, standing around 
yelling doesn't make you more believable...

Anyway, JJ Semple sent me his take on this new format (I've edited this a bit for space reasons):

I think he (the blogger) is very shortsighted. The point here, it seems to me, is to break with 
legacy holdover habits that have complicated film, video, and computer editing for years. 
SIMPLIFY.

I come from a film editing background, worked for NBC News in the 60s and features in the 
70s on 16 and 35mm. It was labor intensive, but much simpler workflow-wise. Cut up the 
scenes, hang them in barrels. Throw everything on a synchronizer and a Moviola. Edit, 
Match and Mix.

In 1995, I directed a short film in 35mm. I had not cut film myself for many years and wanted 
to work with a young editor who knew and used all the new techniques. Suffice it to say I 
was appalled at the convoluted process he had to use. Transferring the 35mm to videotape 
via telecine and digitizing it to work with on a computer, 23.96 and all the makeshift work 
arounds: pulldown, progressive vs. interlaced, bit rate. Heck, even back then I saw that 
digital video would eventually replace film. And if it did, computers would rule the day. What’s 
more, because everything would be handled by computers, there would be no reason to 
retain oddball frame rates like 23.96 and 29.97. You could set a computer to do anything you 
wanted so why not, right from the beginning, set it to some sensible, logical standard that 
makes it easy in terms of resolution and frames per second. Computers can work at any 
speed you choose (11 fps, why not?); all you need to do is to be consistent down the line, as 
long as it offers quality and simplicity. Here is an opportunity for fewer standards, not more.

The first issue is not resolution, but frame rate consistency. Make a camera that would shoot 
at 60p frames or whatever frame rate is the best, capture on HDs, drag the files over to 
computers that understood 60p. If you wanted other resolutions, just make sure they had 
logical ties to the base standard.

If it’s done correctly, in sixty years, people will no longer remember all the mess, they’ll be 
happy working with simple drag-and-drop tools. What separates the pros and the amateurs 
won’t be technical knowledge, but experience and ability.

Case in point. I do most of my work for the web ( http://www.jordansemple.net/my_2008-
09_video_highlights.html). I love the video quality of my Canon HV30 and XH-A1, but I hate 
tape-based capture. Makes me hark back to my 16mm days. As soon as the workprint came 

http://www.jordansemple.net/my_2008-09_video_highlights.html
http://www.jordansemple.net/my_2008-09_video_highlights.html


back from the lab, I’d sync it up and start separating the clips in a barrel. It was actually 
much easier than tape capture. Why? Greater reliability. 

So if you could capture to the optimal resolution on a removable HD, insert said HD into a 
computer slot, drag the files into FCP and not worry about frame rates and pulldown and 
interlacing, wouldn’t that make everyone’s life and workflow a lot easier? And speaking of 
workflow, where did the term come from? It only appeared since the dawn of the digital age. 
Back then, we didn’t need no stinkin’ workflow; we just watched what the editors did and 
when we got a chance to do it, we copied them. We didn’t have to think about what am I 
going to do next. Now I have notes to myself all over the place with workflow diagrams, 
trying to simplify my every process.

Moreover, eventually, if we were able to shoot and edit iFrame at any resolution, not only 
would capture cards become extinct, but FCP wouldn’t need to be as complicated. The 
whole process would consist of a reliable shooting device, reliable storage, editing tools that 
featured editing over technology, and much simpler distribution. Imagine a utility that would 
break a file into clips. Drag the file off the SD card onto the utility and it put the clips into bins 
because in the camera you were able to set logical scene-based markers. You open the 
software (FCP or something better) and you start arranging the clips on the timeline. Whole 
thing is over in seconds...

Make it simple and the rest will follow. 

Larry replies: Thanks, JJ, for your thoughts.
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PASSING THOUGHTS

Quick notes on interesting stuff. 

Michael Coleman sent me the following:

Soundworks Collection: Exclusive Video Profiles of the Sound World 
www.soundworkscollection.com

Two years ago Bay Area Director Michael Coleman started producing exclusive sound for 
film video profiles for the MIX Magazine online audience. These exclusive and intimate 
videos focus on individuals and sound teams behind-the-scenes who bring to life some of 
the worlds most exciting film sound mixes.

With the success of this series, Coleman has launched a new online web destination 
SoundWorksCollection.com with an Oscar sound recognition focus. Every two weeks until 
Oscar night in March 2010, the Soundworks Collection website will release a new sound for 
film profile. You can follow the online series and watch such film profiles as "2012", "Where 
The Wild Things Are", "Terminator Salvation", "The Princess and the Frog", "Invictus", 
"Inglorious Basterds", "Watchmen", and "Star Trek".

Katy Look sent:

'The Specials' is an internet documentary series following a group of friends with learning 
disabilities. Anyway, I've always loved being in the edit but normally its just my job to have 
opinions and drink a lot of tea! Thanks to your course I managed to get my act together and 
I'm pretty pleased with the results. If you're interested, this is the web address for the series: 
http://www.the-specials.com.

http://www.soundworkscollection.com/
http://www.the-specials.com/


Cal Deal sent:

Some months ago you ran a picture I sent you of failed LaCie power supplies. This is really a 
big deal because lots of people are having the problem.

I don't know if I gave you the link to the quick 'n' dirty video I put online about it. It's http://
www.youtube.com/watch?v=tTZ7EvSJnng

I just checked my video for the first time in many months. Scores of thankful people have 
written comments because they experienced the same thing and were relieved to find out it 
wasn't their drive that failed. It really made me feel good to have helped so many people. 
There's one guy who thought he'd lost a 2-hour film he's been putting together. He saw my 
video, borrowed a good power supply and he's back in business.

You might consider putting the video link in your next newsletter!!

Just tryin' to get the word out and help people avoid a lot of heartache! This is really a nasty 
problem.
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READER MAIL

A REASON TO CONSIDER SNOW LEOPARD

Mark writes:

I work with a pair of Sony Z5P and use the Sony MRC1K compact flash recording units on a 
FCS3 system running 10.5.6 and more recently 10.5.8. Most of our jobs are short form, over 
last four months importing was trouble free. 

Recently I updated to 10.5.8 and FCP 7.01 and after tearing my hair out for half a day I 
concluded that OSX 10.5.8 + FCP 7.01 + SonyRecorderUnit111.dmg will cause grief on 
larger files i.e. I presume the problem stems from the splitting files beyond the 4 GB FAT32 
file system - the full clips won't transfer. On each occasion the imported clip length was the 
same i.e. about 21 mins instead of 48 mins.

Desperate I brought the CF cards and external HD home from work - files import fine on my 
10.6.2 system also running FCS3.

Larry replies: Thanks for the update, Mark.

This is an example of where working with the latest operating system helps!
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TRASHING FCP PREFERENCES

Brett writes:

http://www.youtube.com/watch?v=tTZ7EvSJnng
http://www.youtube.com/watch?v=tTZ7EvSJnng


With your tip of the day regarding "trashing your preferences" The body of the instructions 
says..."only trash when FCP is running properly" At the bottom of the instructions (in Capital 
letters) it says...only trash when FCP is NOT running properly. Care to clarify?

Larry replies: Yeah, I need to clean that language up.

The five rules of trashing Final Cut preferences are:

1. Don't trash preferences if Final Cut is working OK. 
2. Only trash preferences after quitting Final Cut. 
3. Only trash files, never trash folders. 
4. Always trash all four preference files as a group, don't just trash one or two. 
5. Always empty the trash when done.

Your confusion was over the wording in rules 1 & 2. Trying to figure out how to write those two so they 
make sense took me the better part of three years.

Here's an article that describes the process. Sorry for the confusion.
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EDITING QUESTIONS FOR PRE-PRODUCTION

Tim McDermot writes:

Anyway I'm getting ready to edit my first paying short film job and have a question for you. I 
was wondering if you had any advice or notes that I should give the production team before 
they shoot. Ha-ha notes that would make my life easier as an Editor. Things you've come 
across over the years that you wish the production would just do for you.

Larry replies: Tim, books have been written on this subject. In fact, check out the new edition of Norman 
Hollyn's The Film Editing Room Handbook, which goes into depth on this issue.

For me, it's making sure you can work with the footage they are shooting. So, get some test footage you 
can practice editing on. Things to learn:

1. What exact video format are they shooting? 
2. Confirm the deliverable - format, specs, everything 
3. Determine how they want to handle dailies and reviews

Then, when you get some footage, make sure you can:

1. Import / transcode it 
2. Burn timecode into it - for reviews 
3. Edit it. 
4. Export it 
5. Convert it with the quality you need for final distribution.

Better to spend time learning this now when you have time, than with everyone screaming at you.
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CREATING BURNED-IN TIMECODE
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Cory Berendzen writes:

I can't find info regarding creating visible audio timecode windows.

For example, I sync my audio wav files with my slates and can output the normal timecode 
window, but the smart slate timecode is different. So I would like to be able to burn-in that 
timecode somehow. Is there a way to burn-in that wav file timecode?

Larry replies: Cory, thanks for writing!

First, only Broadcast WAV files support timecode. Normal WAV and AIF files do not.

You can DISPLAY audio timecode in the Viewer or the Canvas using View > Show Timecode Overlays. 
This displays the timecode of clips in the Timeline.



If the timecode is contained in an auxiliary timecode track, you can display that timecode in the Viewer by 
Control-clicking the top right timecode box and selecting AUX timecode.

However, since an audio clip doesn't have a video file associated with it, there is no way to "burn-in" 
timecode so it displays in your audio clip.
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A FAST WAY TO DISPLAY VIDEO

Beau Tardy told me about this:

If you are looking for a quick way to display video with opening FCP, if you open Quicktime 
Player and turn on 'New Movie Recording' your video should display directly on your screen. 
BTW you can also grab this footage by recording it. If you don't see it right away you may 
need to adjust your Quicktime preferences by opening 'Preferences' and 'Recording'.

Tony Huet adds:

However, keep in mind that this only works with the old Quicktime Player. (The one installed 
with FCP, not the new Snow Leopard one. The new player doesn't even have a Preferences 
menu!) I've used it quite a bit. The only downside is that you can't display the video 
fullscreen. You can zoom in on the screen as a workaround. (Control-scroll wheel)

There is also a delay of several frames between the camera and the screen. 
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MULTICLIP EFFECTS

Mike Menze writes:

Thanks for the presentations you do at CHIFCPUG. find every presentation informative, 
interesting and very useful. I have also watched several of your tutorials. 

I have a question that hopefully you can point me in the right direction to get a good answer/
explanation. I do a fair amount of multicam work. Multicam support in FCP allows you to 
switch camera angles full frame, as to be expected. I would like to have a Picture In Picture 
effect. An example is someone giving a toast at a wedding in the full frame and a reaction 
shot of the bride, parents, etc... in the lower right/left. I used to do this type of stuff prior to 
multicam/multiclip by stacking video with the PIP clip above the full frame clip and scaling/
changing opacity to make the PIP clip fade in and out.

Is there a more elegant not so manual way to do this with multicam editing in Final Cut Pro?? 
I have looked around and have really not found a good answer. Any suggestions, pointers or 
any guidance with this would be very helpful.

Larry replies: Thanks for writing!

Multicam is always full-screen. To do what you want, you'll need to continue stacking clips manually.
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WORKING WITH DSLR VIDEO

Phil Davidson asks:

I'm working with video shot on a Pentax K7 DSLR, using the latest version of FCP.

I've attached the 'item properties' screen for the video below. 
The video plays fine in Quicktime, and fine in the FCP Viewer - but it needs to be rendered 
when I put it in the timeline.

All the various combinations I've tried result in a red render bar - yet when I've dropped the 
K7 video into a timeline using the PAL HDV preset (different frame rate, different 
compressor, different everything) I get an orange render bar.

Surely there is a setting for the sequence that will allow FCP to play the K7 video without 
rendering?

Larry replies: Phil, as long as you are using FCP 6 or 7, there is.

What you need to do is to transcode your DSLR footage into ProRes HQ for editing. None of the DSLR 
cameras provide footage that's ready to edit without transcoding.

Then, set your sequence to ProRes HQ, match the image size and frame rate from your camera and -- no 
more render bars.

Or... just drop the ProRes clip into your FCP sequence and FCP will automatically configure the sequence 
settings for you.

[ Go to Top. ] 



THE POWER OF SAVE AS

Michael Maller writes:

I have just purchased your book Final Cut Pro Power Skills and I wanted to let you know that 
it is a great reference. Thank you for providing such a valuable resource. I have read it cover 
to cover and now I am re-reading it again!

I have a question for you regarding the suggestion (tip) you make about periodically doing a 
save as for your project file. I understand the ramifications for this and I would like to do this 
as you suggested, but when you do this and then capture or log and transfer new footage, 
that new footage is now stored in a new project folder inside the capture scratch folder. So 
now you will have multiple folders for each time you do a save as, and this can accumulate 
and obviously make your media organization into a confused multitude of folders, not to 
mention if you by mistake bring other elements in and put them in an older folder.

Would the only way to avoid this be to move the files from the previous projects name into 
the newly created saved as projects folder and then have to relink?

Is it really worth this trouble in regards to keeping the actual FCP project file clean and 
functioning properly?

Larry replies: Yes, it is worth the trouble to do a Save As.

However, you are correct that if this is ALL you do, then you are going to end up with multiple folders in 
Capture Now.

Instead, do a Save As on your project, as a way to prevent problems.

THEN, rename both the old and new project files. The new file should have the same name as your 
existing project and the old file could have v1, v2, or the last edited date.

Either way, renaming two files is an easy workaround to this problem. As long as your new file has the 
same name as the old file, there won't be any new folders created in your Capture Scratch folder.
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SEPARATING AUDIO TRACKS

Ian Hart, from Australia, sent this in:

I have a feeling you've treated this a while ago in a Newsletter but I can't find the answer.

I'm using FCS 2009

On location I record radio mic into Track 1 and a boom mic into Track 2. I capture the 
sequence with the audio set for discrete tracks, as opposed to stereo. In Final cut pro, 
everything is as expected, with Track 1 on a1 and Track 2 on a2.

I want to mix the audio from both tracks, but apply some noise reduction to the boom mic (air 
conditioning) and some equalization to the radio mic.

When I send this sequence to Sound Track Pro, STP Track 1 and STP Track 2 appear as 



identical stereo tracks with my original RadioMic=Left, BoomMic=Right. I can't separate the 
tracks. 

If I live with the stereo and apply noise reduction to the Right channel (boom mic) or 
Equalization to the Left channel (radio mic) the signals are displaced by about a frame and I 
wind up with an echo.

I'm sure there's a trick here, but I can't work it out.

Larry replies: Ian, when you first emailed me, I sent you a long, laborious work-around. Sigh... The answer 
is actually quite simple.

In Final Cut, if the two tracks are linked, they will import into STP as a stereo pair. If they are not linked, 
they come in as mono tracks.

The way you tell is to look at the audio clip. If the two tracks have small green triangles pointing at each 
other, this means it is a stereo clip and you need to change the clip to dual channel mono to get the import 
into STP to work correctly.

To do this, select the offending audio clip, or clips, then select Modify > Stereo Pair . 



When stereo is unchecked the two tracks import into Soundtrack Pro as separate, mono tracks.

Easy!
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SOLVING AUDIO DROPOUTS

Els van Riel writes from Brussels:

The digitized sound of a recording shows cracks due to one frame drop-outs in the sound, 
every few seconds but not regularly.

If I listen to the original dv tape, the analogue way, it sounds perfect!!!

How come?

Larry replies: My guess is that the problems occurred during capture with the hard disk not able to keep up 
with your incoming data. While audio files and small and easy to capture, video files are not. If your hard 
disk is too slow, it will drop frames. These dropped frames will show up as breaks in the audio.

Once the dropped frames are recorded, they will show up on every system that tries to play the file back.

Or, this is also indicative of editing compressed audio files. Final Cut only supported uncompressed audio: 
WAV, Broadcast WAV, AIF, and SDII files. If you are converting your audio to AAC, AC3, or MPEG-3 files, 
you'll see these same breaks, along with pops and clicks.
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WORKING WITH SOUNDTRACK PRO'S ADAPTIVE LIMITER

Rick Lavon sent me this:

I downloaded your tutorial on the STP limiter...all good info...but I have a question about 
which is better for a final mix.... the basic limiter or the adaptive limiter.

What I have been doing previous to this is exporting a complete AIFF file of my show, 
applying the normalization filter to that track with a -6 dB ceiling, and outputting to DigiBeta. I 



have -20 dB FCP equaling 0 dB on the analog meters. 

Lately a couple of stations have said the audio is not as good as it should be and I have a 
feeling that when the show is encoded and closed captioned, they are making a dub of that 
with a limiter or other form of compression, so that it is maybe getting compressed yet again. 
When it leaves here it sounds fine. So while I can't control what happens after I am done 
with it, I decided to try a different workflow and see if that made a difference.

I exported my AIFF track same as always and saved one version with the adaptive limiter set 
to soft limiter preset and one with the regular limiter based on your numbers in the tutorial. 
The adaptive was definitely punchier and the regular limiter much quieter. Is one preferred 
over the other for general mastering?

Larry replies: The ultimate answer is what sounds better to your ears. I prefer the Limiter, but after your 
article, I'll take a closer look at the Adaptive Limiter.

At this moment, I recommend the Limiter - but I've been known to change my opinion as I learn more about 
a subject.
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RESIZING 4:3 VIDEO

Daniel Simonya asks:

I am working with stubborn colleagues who all have their own vision about resizing 4/3 
footage to 16/9 footage and I like to make an end to it.

For me, resizing 4/3 to 16/9 means that you increase your height from 100 to 133! Some 
colleagues resize it to 123, 128 end even in 116!!!!

Can you provide me with an explanation that will end this battle for once and for all?

Larry replies: Maybe -- it depends upon what you mean by "height."

The only way to create a 16:9 image from a 4:3 image that retains the correct geometry is to zoom into the 
image, thus losing pixels off the top and bottom of the image. 

You do this using Scale in the Motion tab. The problem with scaling footage larger than 100% is that it 
makes your images soft because you are enlarging the image pixels beyond the size they were designed 
for.



Also, as this screen shot illustrates, when you scale the image to fill the frame, not only does the image get 
soft, but you lose part of your image at the top and bottom of the frame.

As for the correct size to scale to, this depends upon the video format.

�●     For 4:3 NTSC, you'd scale to 119
�●     For 4:3 PAL, you'd scale to 134

HD video is already 16:9, so you don't need to scale to create the aspect ratio, but you would need to scale 
to get it to fit into a DV sequence.

You can easily test this for yourself by creating a circle in FCP in one aspect ratio, then trying to stretch it to 
fit another aspect ratio. There is nothing you can do that will alter the aspect ratio of the image that does 
not deform the circle - unless you are wiling to lose pixels.

This is because BOTH 16:9 and 4:3 NTSC DV images contain exactly 720 x 480 pixels (PAL is 720 x 576). 
The only thing that changes is the shape of the pixel -- from short and fat to tall and thin. If the two image 
shapes contained differing amounts of pixels, we could get stretching to work. Because they contain the 
same number of pixels, stretching won't.
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EXPORTING A QUICKTIME MOVIE

Douglas Sullivan writes:

Thank you so much for your tutorial series on Final Cut Studio 2. I was a self-taught editor 
and I can't tell you how much these movies have improved my workflow and sped up my 
editing!

I have a question regarding one of your "essential editing" segments. When you demonstrate 
the "Export > Quicktime Movie" feature, the resulting quicktime movie of the cheetah is 
squished horizontally, due to the pixel shape I assume. Exporting my own project this way 
causes the same issue. What's the proper step to take to ensure the proper aspect ratio for 
the digital QT file? Should it be done at export, or should we export with the sequence 
settings and fix it after the fact?



Larry replies: Thanks for writing and your very kind words.

First, your note makes the assumption that the aspect ratio you see in QuickTime is accurate. This isn't 
correct. QuickTime is displaying your video using square pixels, rather than the rectangles that video uses. 
In general, don't worry about this because the movie is properly sized during compression.

If you need to play the movie directly from QuickTime, but not compress it for the web or DVD, here's a 
video tutorial that I created that explains how to fix the problem.
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EXPORTING STILLS

Nick Strayer writes:

I recently attended your seminar in San Francisco on the 18th and really enjoyed your 
demonstrations and insights. 

1) Whenever I export a still image from my time line using quicktime conversion/still image 
(from format drop down menu) They come out stretched. I shoot on a panasonic hpx170, in 
720 30pN mode, but the images come out as 1280x1080. I have tried creating a new 
sequence with the 1280x720 HD square settings, but still the image comes out to 
1280x1080. Any clue?

2) My second question is about the data rate for my captured clips. When I capture my 
960x720 30pN DVC Pro HD, from my HPX 170 via fire wire, my footage ends up with a 
5.9MB Data Rate. That seems a bit low-is it? My capture pre set is DVC HD Pro 30p, my 
device control is DVC PRO HD Firewire. Is there something I am missing? Do I need a 3rd 
party capture card to get the full benefits of DVC Pro HD?

Larry replies: Nick, thanks for writing. Here are the answers:

1. This image size is normal - the Panasonic 1080 image is actually 1280 x 1080. You need 
to resize your still frame in Photoshop to 1920 x 1080 to make it look normal. Do NOT 
change your sequence settings - that will only make things much worse.

2. Data rate varies by codec (DVCPRO HD, in your case), frame rate, image size, and bit 
depth. While 6 MB/sec seems a bit low, whatever the camera is feeding you should be OK, 
unless there's a hardware problem. If the images look OK, not jittery, to your eye; you're not 
getting any drop-frame errors on capture, and your hardware is all working properly then you 
should be fine. The basic test is image movement. If the images are stable and not jittery, 
you should be fine.
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FIGURING OUT FIELD ORDER, FRAMES, AND INTERLACING

Florian Gintenreiter writes:

I have been in the video-business for a while and I do know what FIELDS and FIELD ODER 
are, but sometimes things happen that make me doubt my "wisdom".

For example: I have 1080i XDCam (natively LOWER FIELD FIRST) footage on a timeline 
that is 1080i ProRes (LOWER FIELD FIRST). its a TV commercial, so there is a couple of 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=138
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=138


video-clips making up the first half of the spot and animated logos and graphics (PSD Files 
imported into FCP) making up the latter half. I render out a Quicktime-Movie of the finished 
film, expecting both halves of the film showing the typical jagged "lines" of interlaced video, 
but behold: I have those "lines" in the video-footage, but the animated graphics at the end 
don't have them.

When I now put the file into compressor for downrezzing to 720x576 PAL and set the source 
video to LOWER (Which is the field order of XDCam and the FCP ProRes Sequence) and 
the OUTPUT field order to PROGRESSIVE (Frame Controls deinterlace ON) the VIDEO-part 
of the commercial gets deinterlaced properly, but I can see aliasing in the charts and 
graphics at the end, as if one of the fields just had been doubled.

When I set the source-video-field-order to NONE, the graphics are fine when downrezzed, 
but the video-part shows strange artifacts, where there should be smooth motion blur. 
Artifacts I would expect from video being downrezzed with wrong settings.

When I switch the sequence in FCP to field order NONE (from LOWER FIELD FIRST) it 
looks like the sequence has no fields anymore, but shows aliasing on the full HD preview 
monitor.

Can you maybe shine some light on how FCP deals with field order especially when using 
graphics and animating them within FCP?

Larry replies: NTSC, PAL, and some HD formats are interlaced. That means that they record every other 
line of your image, then, a fraction of a second later, they record the remaining lines. 

There are several technical reasons why they do this, but when you create video for the web, it drives us all 
nuts.

NTSC and PAL are both lower-field dominant. This means they record all the even-numbered lines of your 
image first, then the odd-numbered lines.

Most HD formats are upper-field dominant, which means they record the odd-numbered lines first. 
However, as you point out, not all HD formats follow this convention.

When you create an animated logo in After Effects, or other graphics software, interlacing is optional. Be 
default, computer graphics are progressive, which means all lines are recorded at once.

You can export an image as interlaced, but, most of the time, images are exported progressively. This 
means that when a clip is imported into a Final Cut sequence and interlacing is added, you won't see it 
because all the lines were recorded at the same time.

This explains why you didn't see interlacing when you first exported the file.

When you down-sample the video from HD to SD, the aliasing you see is not caused by interlacing but by 
the decrease in resolution between HD and SD. This is especially noticeable in computer graphics, which 
tend to contain fine lines and detail which the video camera ignores.

This is the answer to your second question.

Setting the field order to NONE creates video which is not optimized to the PAL standard, which requires 
interlacing, which is why your video looks as bad as you mention in your third question.

A few other things to keep in mind:

�●     FCP does not display interlacing during editing, unless you set the display size of the Viewer or 
Canvas to 100%. 
 

�●     If you are creating a DVD that will be watched in NTSC or PAL on TV, or creating a program for 
broadcast, interlacing is good as it maintains image resolution.  



 
�●     If you are shooting for the web, interlacing will be removed during compression, provided you pick 

an image size that is 50% that of your original source. 
 

�●     If you are creating something exclusively for the web that is not going to be broadcast, you should 
shoot progressive video.

The world will be a better place when interlacing goes away. However, that won't be anytime soon.

[ Go to Top. ] 

CHANGING THE LENGTH OF A MOTION CLIP

Daniel writes:

When I do a round trip from FCP-MOTION-FCP, I can’t change the size of the clip (text, 
picture) on the Timeline any longer. Is there a way to change it? 
 
In my case I created a title, but I need to expand it but unless I re-create the heading I don’t 
find a way to increase the size. I can only move it in the Timeline.

Larry replies: Daniel, that's because you have imported the entire Motion project into Final Cut. In order to 
lengthen the clip, you need handles, which means you need to change the length of your clip in Motion.

To do this:

�●     Select the Motion clip in your FCP timeline.
�●     Control-click the clip and select Open in Editor
�●     Change the length of your clip in Motion.
�●     Save the clip.
�●     Switch to FCP.
�●     Drag the edge of the clip to lengthen it.
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GETTING DVDS TO LAST LONGER

James Calhoun asks:

I've read that our homemade DVDs will have a shelf like of only a few years -- yikes ! In fact 
some that I made years ago with imovie have deteriorated.

How can we get longer lasting results?? Is the DVD quality the problem, or the burners 
themselves, or both ??

Larry replies: Thanks for writing, James.

The organic dye in the DVD is the culprit. Good dyes will last up to 25 years, cheap ones won't. I tend to 
favor Verbatim, MAM-A, and Taiyo-Yuden media.

When it comes to creating DVDs that last, saving money on the disc is the least important item to consider.
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SETTING UP FOR PRORES CAPTURE

The Key Maker sent this in:

I'll like to know how to set my final cut up using the New Pro Res. i believe its already set. 
but while I'm importing there's a Pop Up Screen of the Video. 

Larry replies: At this point, no camera shoots ProRes, so creating a ProRes setting assumes that you have 
converted your footage into ProRes.

The only exception to this is an transcoding option to convert 24 fps HDV to ProRes during capture. You 
can select this in Final Cut Pro > Easy Setup.

Assuming that you've transcoded your material to ProRes, the easiest way to create a ProRes sequence is 
to match the ProRes setting you selected during compression in creating a custom sequence setting using 
Final Cut Pro > Audio / Video settings and matching the Sequence setting menu to your compression 
settings.
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CREATING WMV FILES

Neil McLeod sent in this question:

We have produced an 8 min video using Final Cut Studio 3. For ease of use we have 
created an .mp4 version but the client is also asking for a .wmv file for those of his clients 
who are unfortunately stuck with PCs, and who may not have Quicktime on their systems. 
 
The original has a “Motion” opening and when we export the whole movie in Final Cut using 
Export > Using Quicktime Conversion > Windows Media, only the “Motion” section 
converts. 
 
When we removed the “Motion” section and ran the conversion again, only the first Final Cut 
clip converted. There are transitions between most clips.

We have tried the same procedure using “Flip4Mac” and also “MPEG Streamclip” with 
identical results.

If we export the .mp4 to an .avi it works in full but the file size increases. If we then try to 
convert the .avi to .wmv we again get the limited conversion only.

We raised this at the Genius Bar in the new Apple store here in Aberdeen but they are 
mystified.

What am I missing?

UPDATE - Jan. 2, 2010



Matt Davis writes:

Silly straight-up answer: if only the first 30 seconds of your movie is encoding, you may have 
not 'upgraded' the Flip4Mac license to something that compresses (e.g. Studio, HD). Right, 
now that forehead slapper is out of the way...

I would try using Export > QuickTime Movie, and make it self contained, using your editing 
codec (or ProRes HQ and up if you know why you need it). That gives you one perfect movie 
to work from.

Then take this through your choice of encoding software that uses the Flip4Mac WMV 
component and experiment from there:

- Compressor 
- Episode 
- Squeeze or even 
- QuickTime Pro player (the V7 version, not Snow Leopard's version)

One oddness I and a colleague have noticed which may be limited to our setups is that the 
WMVs appear to have a 3 frame sync issue, but checking them on a PC - even Parallels - 
shows that they work fine for the intended audience.

I'm a little leery of exporting movies for encoding which are not self contained, and also 
would not want FCP doing the encoding as there's so much more one can do in a specialist 
app. Furthermore, even on a MacBook Pro, I can edit and encode at the same time.

Anneli Tofte, from Stockholm, adds:

In the last newsletter Neil McLeod wrote about trouble converting to wmv. In my experience 
it is often better to export the sequence to a movie file in its native format and open the 
movie file in Quick Time Pro 7 (in my case QT 7.6.4) and convert it from there. I have 
Flip4mac on my system but I think QT is more reliable than FCP when exporting to wmv.

Craig Moore adds:

I'm assuming that he doesn't have the full Flip4Mac software/codec and thus only getting a 
30 demo/test clip export.

It doesn't matter what program you are using if you have installed Flip4Mac as they will 
default to using that codec (i'm pretty sure).

You could find a version of VisualHub and use that (it doesn't use the flip4mac codec) but it 
uses a much older version of Windows media.

I'd recommend using a video share site like vimeo (plus) and use password protected 
uploads for viewing or even user restricted sharing on youtube if it's not confidential.

UPDATE - Jan. 5, 2010

Clint Hayes writes:

Regarding Neil McLeod's WMV conversion issue, it sounds like he's experiencing the same 
thing I was last spring. Any WMV conversion I attempted would cut off at thirty seconds, 
regardless of the application I was using, be it FCP, Streamclip, or Flip4Mac. I finally learned 
that it was my trial copy of Telestream's Flip4Mac that was limiting me. It says on the 
Telestream website: 

"Flip4Mac WMV Player operates in trial mode until you purchase a license. During the trial 
period, all features are enabled but the components will restrict the duration of any export to 



Windows Media to 30 seconds. Importing a WMV file into QuickTime or QuickTime based 
applications and converting those files to QT compatible files will result in a video 
watermarked with the Flip4Mac trademark. Once a file is converted while in trial mode, the 
watermark cannot be removed."

Once I purchased the full version of Flip4Mac, voila, I got full conversions. It appears those 
other apps use the Flip4Mac conversion for their encoding, because that solved the issue 
across all of the affected apps.

Hopefully that helps Neil, if you haven't learned it from somebody else already.

As a note, a quick study of the features shows that anything less than Flip4Mac Studio Pro 
($99) probably won't be of much use to professional videographers. They should take a 
close look at the asterisks in the feature list before they decide on a package. They're fairly 
limited in frame sizes and WMA9 export ability with anything less than Studio Pro.

Larry replies: Thanks, everyone, for writing. 
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CREATING BACKUPS

Louise Fleming writes:

My question is HOW do I back-up [in FCP] for a specific edited segment. The edited 
segment I want to back-up onto a DVD.

Any advice would be greatly appreciated. 

Larry replies: Hmmm... I'm not clear on exactly what you are asking.

�●     If all you want to do is make a copy of an edited sequence, select the sequence in the Browser and 
choose Edit > Duplicate. 
 

�●     If you want to make a backup of a project file, quit Final Cut (to be sure your project file is properly 
updated and closed), select the project file icon and choose Edit > Duplicate from the Finder menu. 
 

�●     If you want to make a back-up of your project to a DVD, simply drag it into a Burn folder in the 
Finder and burn a data DVD.



�●     If you want to make a back-up of an edited sequence as a movie, without compressing it, in other 
words to create a data dvd, select File > Export > QuickTime Movie, make sure Setting is set to 
Current Settings, and Make Movie Self-Contained is checked.

Then, use the Burn folder function inside OS X. However this limits you to movie that is 4 GB in size or 
smaller. Use Mac Help to learn how to create a burn folder.

If, on the other hand, you want to play the movie on a DVD player, the easiest thing to do is export your 
movie, as indicated above, then use iDVD to create your DVD.
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ICHAT THEATER

Mike White asks:

We have a project that i am editing. The director is in another location. What would be a 
good way to show the director the progress on the editing of the project? I have imovie 09. I 
am trying to avoid having to burn a DVD every time i need to show the director something. 
Any suggestions?

Larry replies: There is no sharing option in iMovie 09. However, one of the big new features in Final Cut 
Pro 7 (the latest release) is iChat Theater.

This allows you to set up a video chat between two Macintosh computers and play your Final Cut sequence 
out to the iChat conference. This allows your clients to see you work, even when they are not in the same 
location as you are.

If you have lots of remote clients, this feature alone would make it worthwhile to consider upgrading to Final 
Cut Studio.
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WRAP-UP

Well, that's about it for this newsletter. I'm finally starting to get caught up on my email backlog.

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the 
Digital Production BuZZ every week. In fact, email me on how you can put the free BuZZ player on your 
website! 

�●     Visit our store and buy some of our latest tutorials. 
�●     Check out our current seminar series, I'd love to meet you! 

Also, please continue sending me your comments and questions. I love hearing from you and enjoy the 
conversations that develop around your comments.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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